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C O M M A N D. C O M
Attendance at the
November general meeting
60 members and guests
We welcome one new member

To Contact CIPCUG
The Outer Edge......................805-485-7121
General Information………...805-289-3960
Mailing Address...P.O. Box 51354, Oxnard, CA
93031-1354

Computer tuneup
scheduled in January
The next computer tuneup will be at the
January meeting. A sign-up sheet will be
posted on the CIPCUG website. The tuneups
cost $15 per computer and consist of a quick
check for possible problems.
If the problems can’t be fixed in the available time, Rick Smith or Michael Shalkey will
suggest solutions you can perform at home or
tell you if the machine must be taken to a shop
for more extensive analysis and work.
The tuneups are available only to CIPCUG
members, but that includes anyone who joins
the same day.

By Rick Curry, President

H

appy Thanksgiving. Two important announcements: First, the
December meeting will be on the 3rd Saturday (the 18th). Second,
our bylaws declare that my presidency ends with our next election in May.
Most of our club officers are generously serving from year to year, although a club member may run for any position on the board by communicating the desire to run to a board member. The office of president has a maximum two-year term, and I must step down from
my bully pulpit next spring.
Consider putting your hat in the ring. The responsibilities of
the club president are not overwhelming. People can make this
job as big as they want, but the duties are attending the meetings and writing this column. I recommend the job as an opporCurry
tunity to participate in a volunteer organization with some great
people to work with, and an inquisitive and engaged club membership. You also get a chance to practice a little writing, public speaking,
and Robert’s Rules of Order. There will likely be an additional incentive for
the incoming board in the form of an office suite of programs. The software
comes heavily discounted for use by nonprofit organizations in their operation. So that all board members can use the same tools on shared documents,
this office software will be made available to board members elected next
May.
Safe online holiday shopping
Last year, the American Bar Association published some tips for avoiding
the spiders when we do our holiday shopping from the worldwide Web.
They are still great advice and can be found at http://www.safeshopping.org/
tips.shtml
Some of my favorite tips from that article:
Trust your instincts: if something seems wrong, get out [and preferably
reboot!]
If you use auctions (this includes eBay), understand the terms and conditions.
Make sure the connection is secure.
(Continued on page 11)
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Coming events

OneNote, Christmas gifts topics for December
Programs
Toby Scott will discuss Microsoft
OneNote and Michael Shalkey will discuss Christmas gifts and gadgets at the
December meeting.
Don’t forget that the November and
December meetings are on the third Saturday of the month because of the holidays, making the December meeting date
Dec. 18. We’ll meet at the Camarillo
Boys & Girls Club, 1500 Temple Ave.
(Ponderosa Drive and Temple Avenue),
Camarillo. (See the map on the last page.)
The doors open at 8:30 a.m. The
Internet and Networking SIG and the
Hands-On Training meeting (Computing
101) will start at 8:45 a.m.
Microsoft describes OneNote, part of
the Microsoft Office Suite, this way on its
Web page:
“Microsoft OneNote 2010 is a digital
notebook that provides a single place
where you can gather all of your notes
and information, with the added benefits
of powerful search capabilities to find
what you are looking for quickly, plus
easy-to-use shared notebooks so you can

Door prizes

The club gets 10 percent of the sales
price. Sold items must be picked up at
the end of the day’s meeting. Any items
not picked up will become the property of
CIPCUG and will be subject to disposal
at the club’s discretion.
CIPCUG is not responsible in any
way for items bought or sold at the table.
Each item is sold as-is unless otherwise
stated.

We have two types of raffle tickets:
one for prizes offered by the presenter
and one for club-provided prizes. The
tickets for the presenter’s prizes are free
and limited to one per member.
The tickets for the club-provided
prizes are $1 each, $5 for six tickets, $10
for 13 tickets, $15 for 20 tickets and $20
for 27 tickets and are available to
anyone. Those who can’t stay until the Meeting, SIG notices
drawing may sign their tickets and give
If you would like e-mail notices of
the person selling the tickets a list of the
prizes they would like in the order they’d regular meetings and SIGs, go to
pick them. Winners’ prizes will be held www.cipcug.org, where you’ll find a link
on the home page to sign up. The URL is
until the next meeting.
cipcug.org/listserv.cfm.
Consignment table
You will need your membership
A consignment table is set up at every number, which is on the back cover of
meeting. Anyone can buy, but only TOE, to complete the sign-up.
members can sell.

manage information overload and work
together with others more effectively.
“Unlike paper-based systems, word
processing programs, e-mail systems, or
other productivity programs, OneNote
delivers the flexibility to gather and or-

ganize text, pictures, digital handwriting,
audio and video recordings, and more —
all in one digital notebook on your computer. OneNote can help you become
more productive by keeping the informa(Continued on page 4)

Minutes of the November board meeting
The November board of directors
meeting was held after the regular CIPCUG meeting on Nov. 20 at the Camarillo Boys & Girls Club. Present were
President Rick Curry, Vice President
Craig Ladd, Treasurer Art Lewis, Immediate Past President Paul Westefer, Membership Chairman Ken Church, Web page
Coordinator Helen Long, Technical Adviser Toby Scott, and TOE editor John
Weigle.
Rick said that we should update the
programs on the CIPCUG flash drive. He
and Toby are working on it.
Treasurer Art Lewis presented the
treasurer’s report, which is published
elsewhere in TOE. He noted that there
was no raffle money for the month because the report was for the meeting we
had in the church, not the Boys & Girls
Cub.
Craig asked about an e-mail from one

of our members suggesting that the club
set up a honeypot — a computer with a
fresh installation of Windows but no security software — so members could see
how easy it is to get infected with malware. Toby said it would be interestingm
but that the computer would have to be
used by someone, not just be connected to
the Internet. Setting up a honeypot isn’t
easy, Toby said. Rick said that hackers
are also aware of them.
Craig said that Jessica Scott had suggested changing the name of the Computing 101 SIG to Hands-on Training. Attendance has been small recently, and she
thinks that might entice more people to
attend. The idea was approved.
Art commented we had discussed
printing business cards with meeting
dates and locations and phone numbers to
distribute to interested people. No specific action was taken, but the board was

agreeable.
Craig said he has not confirmed any
programs for next year, but he’s working
with the FBI and NovaStor and would
welcome any ideas.
Toby said he could demonstrate OneNote and Michael could discuss Christmas presents and gifts at the December
meeting, and his offer was accepted.
January’s Computer Tuneup will be
pushed at the next meeting.
In light of Rick’s comments at the
business meeting about this being the last
year of his term, the board noted that
elections will be in May. If you’re asked
by the nominating committee if you’re
interested in seeking an office, please
give the idea serious consideration.
The meeting adjourned at 12:34 p.m.
Respectfully submitted,
John Weigle, acting secretary
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Q&A

Many ask questions about e-mail problems
Unless otherwise noted, the questions
are answered by Toby Scott, our
technical adviser and a partner in
Ventura County Computers. Michael
Shalkey runs the computer. — Editor
Internet and networking SIG
Reported by John Weigle
Were messages sent?
Q: In Outlook, how do you know that
messages were really sent?
A: If the message goes into the Sent
Items folder it has been sent.
E-mail requires a client-server connection. The server sends the e-mail program a message that it has gotten all the
messages, and when that message arrives,
the messages go into the Sent folder. That
does not necessarily mean the messages
will reach the intended recipients. For

instance, if you mistype the address —
such as typing “,com” instead of “.com”)
— the server will try to deliver it and find
out there’s no such address. You might
get an immediate response in that case or
it might take a few hours or days to get a
notice back that the message could not be
delivered.
Both the sender and the receiving
server send each other a hash number —
a count of the bits sent and received —
and if the numbers match, the client sends
an ACK (acknowledgement). If the numbers don’t match, a NACK (negative acknowledgement) is sent, in which case
the material is resent.
When you’re downloading something,
the server has to get a message back that
all is OK. If that message comes, the
server deletes the message. If a problem,

such as a power glitch or failure, occurs,
the ACK message doesn’t come, and the
messages are kept on the server, and the
next time your download e-mail you’ll
get some duplicates.
Q: Don’t you get a message on a malformed address?
A: Yes, but it might take a day or two.
Q: Where is the message during that
time?
A: There are lots of NACKs on the
Internet — a slow page download can be
a sign of that. When you send e-mail and
it’s not accepted, the server will resend it
several times before finally giving up and
telling you the message couldn’t be delivered. Some servers will hold messages for
up to four days while trying to deliver
them. The messages are sitting on the
(Continued on page 5)

More on coming events ...
(Continued from page 3)

tion you need at your fingertips and reducing time spent searching for information across e-mail messages, paper notebooks, file folders, and printouts.
“OneNote 2010 is an integrated part
of Microsoft Office 2010, which makes it
easy to gather, organize, find, and share
your notes and information more efficiently and effectively. Powerful search
capabilities can help you locate information from text within pictures or from
spoken words in audio and video recordings. And easy-to-use collaborative
tools help teams work together with all of
this information in shared notebooks,
whether online or offline.”
No programs are set yet for meetings
in 2011, although the Computer Tuneup
is planned for the Jan. 22 meeting.
SIGs
Except for the Thousand Oaks PC
Club Photo Group, the Special Interest
Groups (SIGs) are sponsored by CIPCUG
and led by volunteer club members.
Unless otherwise noted, the CIPCUG
SIGs run from 6:30 to 8:30 p.m. at
Ventura County Computers, 2175

Goodyear Ave., Unit 117, Ventura; phone
289-3960. From the 101 Freeway, exit at
Telephone, take Telephone south to
McGrath, turn left and go one block. Turn
right on Goodyear and right again into the
second driveway. Unit 117 is the back,
right corner of the building.
The pre-meeting SIGs are at 8:45 a.m.
at the Boys & Girls Club. The aftermeeting SIG is at 1:30 p.m. at The Star,
550 Camarillo Center Drive, Camarillo.
There is no charge for members to
attend the CIPCUG SIGs.
Until further notice, the Photo
Group is not accepting new members
or guests because it is close to
outgrowing its meeting room. The
TOPCC Photo Group, which meets at
6:30 p.m. at the Thousand Oaks Library,
1401 E. Janss Road, charges $3 per
meeting for those who are not members
of the Thousand Oaks PC Club. The Web
site is http://topcc.org/dnn/SIGsPrograms/
PhotoGroup/tabid/65/Default.aspx.
The general schedule:
First Monday (except in months that
have holidays on or near the first
Monday): TOPCC Photo Group. It is not

taking new members or guests until
further notice.
Fourth Tuesday: Linux.
Fourth Saturday (or the regular
meeting day): Hands-on Training
(Jessica Scott and Mark Maidel) and
Internet and connectivity SIG, 8:45 a.m.
Michael Shalkey’s after-meeting SIG at
The Star, 550 Camarillo Center Drive,
Camarillo.
December
Saturday, Dec. 18: regular meeting
and SIGs. Michael Shalkey’s aftermeeting SIG (What To Ask For This
Christmas and What Can Wait)
Tuesday, Dec. 21: Linux SIG. Topic:
Completing installation of Ubuntu, discussing PC rescues with Ubuntu and answering questions.
January
Saturday, Jan. 22: Regular meeting,
pre-meeting SIGS, and Michael
Shalkey’s after-meeting SIG.
Tuesday, Jan. 25: Linux SIG
Be sure to check the calendar on
cipcug.org for updates on event programs, dates and times.
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More Q&A: E-mail failure notices and other issues
(Continued from page 4)

server that is trying to deliver them.
Canceling outgoing mail
Q: Gmail has a feature to cancel outgoing e-mail. I tried it, and it worked.
How do they do that?
A: I don’t know for sure. If you send
“cancel” before it’s sent, the NACK message will be sent. The server sends a
HELO message saying, I’m ready to start,
and if the message is gone, the HELO
message isn’t answered.
Michael: Google has set up a feature
for Gmail that gives you a way to delay
sending messages written late Friday
night. It’s called Mail Goggles. A portion
of the entry on the Gmail blog describing
the feature says:
“When you enable Mail Goggles, it
will check that you’re really sure you
want to send that late night Friday email.
And what better way to check than by
making you solve a few simple math
problems after you click send to verify
you’re in the right state of mind?
“By default, Mail Goggles is only
active late night on the weekend as that is
the time you’re most likely to need it.
Once enabled, you can adjust when it’s
active in the General settings.”
The full article is at gmailblog.blogspot.com/2008/.../new-in-labsstop-sending-mail-you-later.html. If you
want to activate the feature, go to “Labs”
tab in Gmail. You can adjust the settings
in the “General” tab.
Failure notices
Q: I send a message to 50 people and
get some “bad address” messages back.
How do I know the message went to others on the list?
A: It goes to the addresses that you
don’t get a bounce notice on. Sending
doesn’t stop when a bad address shows
up because it’s like you hit send 50 times.
If you get a 400 error message, it means
the message was temporarily delayed.
Don’t worry about those.
Junk mail filters
Q: I have an AOL account. How does
Outlook know what messages are junk?
A: Outlook and Hotmail are both Microsoft products and compare their databases to determine junk mail. Some peo-

Solid state drives
Adding a second drive
Making two drives look like one
Bank website problem
Can’t get sound on a video
32-, 64-bit questions on SSD
Connecting a SATA drive
Windows 7 OEM
Enabling network adaptor
E-mail malware
Updating Java
‘Enable global object security pol-

This month’s Q&A topics:
Internet and e-networking SIG
Were messages sent?
Canceling outgoing mail
Failure notices
Junk mail filters
Messages that don’t send
Leaving messages on servers
Gmail limits
Skype connection; overheating
Solid state drives
Webcam stops working
Regular Q&A
Fundraisers

ple classify newsletters they no longer
want as junk rather than unsubscribing,
and if enough people do that, the database
will start classifying the messages as
junk. You can set your Outlook protection at levels from Low to High, but High
will probably classify many things you
want as junk.
Be careful about clicking unsubscribe
links on unsolicited mail because in many
cases the senders will add your confirmed
address to a list they sell to others. You
can unsubscribe to Yahoo groups, Google
groups, Microsoft, Amazon and other
big-name sites safely, but don’t do it on
material you never asked for. That just
gets your address on more authenticated
recipient lists and you’ll get even more
spam.
I find it interesting that some Microsoft TechNet articles are classified as
junk.
Messages that don’t send
Q: Sometimes, my mail program
won’t send messages to the server. They
just sit in the Outbox forever. I’ll get a
message that there is an error in the address. Is it possible that these messages
are going out?
A: If your computer detects the error
and doesn’t send the message to the Sent
Items folder, it didn’t go out. If it’s in the
Sent Items folder it went out. Some programs will detect malformed e-mail addresses and not send it, but the message
will sit in your Outbox forever generating

icy’
Do upgrades change settings?
SSD reliability

error messages until you delete the message or fix the address.
Leaving messages on servers
Q: If I delete messages, does that delete them from the server? Can I make it
do that?
A: Messages that you’ve downloaded
should automatically be deleted on the
server. If they’re not, you can go to advanced settings in your e-mail program
and uncheck “leave copy of message on
server.”
If you download messages on two
computers, such as home and work, you
can use the setting to be sure that messages stay on the server long enough to
download them on both computers. But
don’t pick an overly long period if you do
that. We had a CIPCUG member a couple
of years ago who had a gigabyte worth of
material in his Inbox and I fussed about
that. We have a limited amount of server
space and if many people did that, we’d
be in trouble. It was a mess trying to
clean it up because all the spam messages
were still there; nothing had ever been
deleted.
Gmail limits
Q: Gmail keeps messages forever,
right?
A: There are some limits, but they’re
in the gigabytes range. The limit appears
to be 7.5 gigabytes.
Audience comment: And they keep
increasing that.
(Continued on page 6)
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More Q&A: Computer overheating, solid state drives
(Continued from page 5)

Skype connection; overheating
Q: I’m using Skype and it works fine
with one person but with someone else, it
starts to get pixilated and then we lose the
connection. Theirs is a fairly new computer, but they have had problems in the
past with overheating.
A: If it’s an overheating problem, they
want to get it fixed quickly because they
can burn up the power supply and motherboard. The connection problems could
also be caused by spyware, viruses, or a
bad connection. This is a classic case of
the problem being at their end, not yours,
though. Again, if their computer is overheating, they need to find out why and get
it fixed. If the computer is hot when you
touch it or you get overheating messages,
quit what you’re doing and take it to a
shop.
Overheating can be caused by dust,
animal fur, anything that can be sucked
into the computer. Keeping it on the floor
is not a good idea, but getting it even a
few inches off the floor will help prevent
problems. A thermal blanket is created by
what’s sucked in, and that keeps heat
from dissipating.
The computer is not going to get better if it has a heat problem; it’s going to
get worse. Our minimum charge is $40,
but if you let the problem go and blow up
the computer, it’s going to be $200 or
more as we replace whatever parts you
burned out.
Michael: It’s the same as a car. If the
check engine light comes on and the car
starts to shake, you don’t keep driving it
in hopes it will get better and the problem
will go away.
Toby: A vacuum cleaner will suck the
dust and junk out, but canned air is usually a better solution. But be sure to get
the ones made for electronics. The others
use oil as a propellant, and if you coat
your motherboard and power supply in
oil, you’ve just made the problems worse.
Don’t cheap out on this. And if you have
both types of air cleaners around be sure
to use the right one.
Audience comment: Also the electronics one has fluorocarbon, which is
both flammable and carcinogenic, so it
should be used outdoors, not inside.

Q: Is there a program to detect overheating?
A: Lots of motherboards have a monitor that will pop up an overheating message.
Q: Can you install on if the motherboard doesn’t have one?
A: No.
Q: Can you measure the heat coming
out of a power supply?
A: It would probably work if you had
a proper benchmark when it was new.
Q: I run my tower without a cover. Is
that a problem?
A: You’ll need to clean it more often,
but you’ll see when it’s time. If you do
that, don’t have it sitting on the carpet.
Getting it even a couple of inches off the
carpet will help tremendously.
Q: Do you regularly blow out the machines you work on?
A: Yes, if there is any significant dust
it’s the first thing we do.
Michael: Probably 50 to 75 percent of
the computers that come in have some
thermal blanket problem. It’s sometimes
hard to tell because you can’t be sure
what caused certain problems, but heating
affects chips, the motherboard and power
supplies, so you don’t always know what
has weakened them if they die later.
Solid state drives
Q: Does a solid state hard drive make
a difference?
A: Yes. It’s like a flash drive and
doesn’t generate much heat. Heat is cumulative inside the box and mechanical
hard drives generate a lot of heat that gets
transferred to other components. This is
especially true in laptops.
Q: Can you compare the two types?
A: Yes, but let’s do it in the regular
Q&A where it will be recorded for TOE.
Ask me again then.
Q: Can you have an external solid
state drive?
A: Yes, but you’ll have to connect
with the slower tools (USB, etc.). Everything is constrained by its slowest point,
and that’s often the transmission time.
Webcam stops working
Q: My webcam has suddenly stopped
working.
A: Do other USB devices work on the

computer (the answer was yes). If you
unplug the camera and plug it back in, do
you get the new hardware found message
(the questioner hadn’t looked for it).
Check the USB port with another USB
device and see if that one works. If it
doesn’t there’s probably a problem with
the port. If you don’t get the new hardware found message, it means the computer isn’t picking it up. Unless it’s an
expensive camera, it’s probably not worth
fixing it because it will be cheaper to buy
a new camera.
Michael: You could try plugging the
camera into another computer and see if it
works there.
Regular Q&A
Reported by Diane Mortensen
Fundraisers
Toby: At the earlier SIG there was a
question that I was going to cover about
solid state drives …
From the audience: Question asked
about “The Secret Guide to Computers”
and freeware flash drives.
A: The computer book did not come
out. We have been doing “The Secret
Guide to Computers” forever, and the guy
who writes it said he was coming out with
a new version, but it is not out. Historically, it has been a good reference book
and we would like to see a new version
and probably order some, but it has to be
a new book. A 4-year-old book is not too
useful at this point in computer years; it
covers only XP.
Regarding the freeware flash drives,
we bought the 4GB flash drives and received a great price on them at that time.
What we have in mind is to do an 8GB
flash drive and do the freeware and put on
additional programs. The problem with
that is that the solid state drive is coming
out and all that memory has stayed high
in price, and, basically, if we wanted to
do another freeware drive, it would have
to be on an 8GB drive. The prices have
not fallen like we had hoped they would.
We were penciling in to do one for
Christmas this year, but with the prices
remaining high, it would not be feasible.
(Continued on page 7)
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More Q&A: Using solid state drives
(Continued from page 6)

What will happen is that we will be
able to get the first price cut when they
come out with the 8GB flash drive. We
had wanted to offer them for not that
much more than you would purchase the
same size flash drive in stores, and you
get the freeware programs thrown in. The
club would make a little profit, and it
would be a good deal for everyone.
However, it has to be at the right time,
and we are not there yet. It costs about $4
extra charge to get the CIPCUG logo put
on the flash drives. We did this with the
Kingston flash drives, which turned out to
be great drives. Mine still works and has
been in my pocket every day for about
two years. We bought the 4GB in quantities of 100 and, the price was about the
same as putting the logo on and a little
less than you could buy the same drive
for in stores. We have to do something
similar or it will not be feasible. The plan
was to have an update on the freeware by
the December meeting so all of you get a
Christmas present.
Solid state drives
Toby : Now, can we go into discussing
solid state drives?
Announcement by Craig: The Thousand Oaks computer club has a new freeware disk they are putting out this month
and next. These sell for about $5.
(Craig later provided this information:
(“To see a list of programs on the
disc, go to http://topcc.org and click on
‘Favorite Utilities’ at the upper right.
You will be prompted to log in.
(“If you don't know what your user
name or password for this website is,
follow the instructions on page 2 [which
is also in the ‘Help’ button on the web
site menu]:
“(http://topcc.org/dnn/
LinkClick.aspx?fileticket=n8ZQfNArkM%3d&tabid=128)”
Toby: Back to the inquiry — The
standard hard drive we have been using
for about 20 years, if you do not count the
electronics, is basically a platter or a couple of platters and it spins around in a
circle and this little arm has a button on
the end of it which picks up electronic
signals off of the drive as it spins and it
reads the data that way. The drive will

spin rapidly — the typical laptop drive is
a 5,400 RPM and the standard workstation drive is 7,200. Server quality
drives go up to 12,000 RPM or even
some 15,000 RPM drives. There is a limit
on how fast you can spin that stuff reliably before you start having a warping
problem. You are not going to get much
more speed out of those drives than they
already have. It is running into physical
limitations of the media.
Solid state drives (SSDs) are all electronic, and there is there is a lot of theoretical head room before you get to the
maximum speed of solid state drives.
The drives are still smaller than the spinning drives so right now, you can get
relatively inexpensive spinning drives up
to 1TB and then the price starts to go up.
Almost any drive 500GB or less is close
to the same price. It is basically the cost
of the metal and electronics that it contains and how much data is on it, but
there is very little difference in price.
The SSD drives are a little pricier and
after that they go way up.
The solid state drives come in 40GB,
which is really not enough for Windows
7; it is enough for any of the XPs, but you
have to have a SATA drive not an IDE
drive. If you have XP with SATA drives
and you want to get some speed enhancement out of it, you can install your operating system on a 40GB drive for about
$100. The 80GB drives are around $175.
The 160GB are about $350-$400 and
after that they can go much higher. So
they can get pricey quickly.
When you are using your computer,
way more time is spent on opening up the
program than opening up the data. The
size of the Word footprint that you open
up is usually about 30 or 40 times larger
than the size of the Word file you are
opening. It allows you to install the Word
program on your flash drive, your solid
state drive, and you can put your Word
data on a D or E drive — one of the old
spinning jobs. Although it is slower, you
get 95 percent of the advantage of the
speed of your solid state drive. You can
make that work pretty nicely. An 80GB
drive for Windows 7 and Vista, 40GB
drive for Windows XP, put all your data
on a spinning drive on a desktop not a

laptop and you are good to go.
We had a customer who ordered two
identical computers, but one had a regular
drive and the other a solid state drive.
The regular computer — bearing in mind
we had no programs, anti-virus, no nothing — the regular drive booted in 15 seconds. With the solid state drive it booted
in 7 seconds. It is a 43-57 percent increase in speed.
Q: Did you notice the pick up in speed
on the installed time, when you installed
the programs?
A: Yes, very noticeable. It takes about
15 minutes to install an entire Windows 7
program. Solid state drives are twice as
fast as a regular SATA drive. Almost
everything you would do on the solid
state drive will take half the time as the
regular drive. These are really game
changers, and for any of you who really
want to pick up speed, particularly if you
have a computer where it is running OK,
but you would like to give it a real punch.
You may not be ready to buy a whole
new computer, rather satisfied with what
you have, but really would like a big pick
up in speed. If you put on a solid state
drive your computer would really sizzle.
With the desktop, we stick a secondary
drive in for data and put all of the stuff on
the secondary drive and let it spin. It is
slow, but anytime when you start up a
program, the data is always a small component. The footprint of the program
itself is the larger component. It really
makes a huge difference.
Q: If you are using a photo imaging
program like Photoshop, would that speed
it up?
A: Yes, but you will need a bigger
hard drive because Photoshop is big.
Even with XP, I do not believe you could
get away with 40, you are into 80 and
with Windows 7 you might even want a
160. People who have Photoshop, not the
stripped down version, usually have a lot
of other big stuff. Photos can go on a G
drive, but the program itself is large.
Adobe has not written a small program in
its life. Watch out, we have not had to
worry about this for a long, but you need
to have 25 percent of your hard drive free
at all times. You do not want to get it any
(Continued on page 8)

Page 8

The Outer Edge

December 2010

More Q&A: RAID drives, bank site in Chrome
(Continued from page 7)

tighter than that because Windows is constantly creating temp files, doing stuff in
the background and so on. If you get hard
drive bound where you do not have much
free space, it cannot move it around and it
ends up getting badly checker boarded. If
you get below 15 percent you cannot
even effectively defrag. Be at least 25
percent free at all times.
Adding a second drive
Q: Can I have a second drive if my
first drive is full or close to full?
A: If you have a hard drive and it is
full — and usually it is a combination of
a lot of programs and a lot of data — it is
quite easy to get a new hard drive. You
can put the new hard drive as a D or E
drive; move all your data to it, and you
can change the location of My Documents so that it goes to D or E or another
drive. You could move all that stuff to a
second drive. That will free up a lot of
space on your C drive and you will be
back in business. Sometimes we do it the
other way around, because if you buy a
new drive what we can do is get a bigger
drive and then clone the drive so that you
have two identical copies. Make the new
drive the C: drive which usually has a
longer life expectancy and so you can
boot off of it and then go into the D drive
and you can delete all the operating system off of it and just leave the data on it
and then make your pointer go into the
data drive.
Making two drives look like one
Q: Is there software that will make
two physical hard drives look like a single drive?
A: Yes it is called RAID. If you are
talking about making the two drives linear, that is if you have two 500GB drives
you end up with 1TB of data storage,
which would be RAID zero. Yes, you can
do that, it makes your computer significantly faster, not like a solid state drive,
but it will make it faster. However, if one
of the hard drives dies, all the data is
gone. You get nothing off the other drive
because they are locked together logically
when a program writes. In order to get the
speed, they write one packet to drive A,
the next to drive B. Half of every program is on each disk, half of every data

file is on each disk, and if one dies it is all
gone. You better have backups because
you more than doubled your risk of catastrophic loss.
If a single hard drive dies, a lot of
times in the shop we can run other tools
and bring it back. If you have a marginal
problem with one of the two drives and it
breaks the RAID you are done, there is no
way of resurrecting that. Can you install a
RAID zero, yes you can. Would I suggest
it, No. I would not do it, but if you want
to try it we will give you four hours of
caveat before we do. This is only the beginning, folks, if you come in and say you
want to do it. If you are an extreme gamer
and you get your game stuff going exactly the way you want it and you make a
perfect image copy of it in order to restore it, and you are not getting any new
data that you really want to save, then it
speeds up things and gamers who are in
to “I can shoot you quicker than you can
shot me, if I can get a little faster hard
drive, I can see the picture faster than you
do,” it will give a little edge like that. For
anybody else, no, it is not recommended.
It is not recommended by anyone.
Bank website problem
Q: On my laptop, I can go to Firefox,
Internet Explore, and Chrome. I can go to
Citibank, open up my credit card statement, hit download and it opens up.
When I go to my desktop, I can do the
same thing in Firefox and Internet Explore; however, when I go to Chrome, I
click on the download the statement and I
can see it instantly, and then it goes to
blank and flashes back. My question is do
I need to put in some type of setting to
prevent them from opening up?
A: Do you save the icons on your
desktop as shortcuts? What are you clicking on your desktop that causes you to go
to your bank statements? Are they icons
on your desktop? If so, go to your bank
and go to Chrome and get a startup page
from your bank and create the shortcut
again and replace it.
Highlight what you want a shortcut to,
copy and then go to desktop, right mouse
click, create shortcut, new shortcut, properties, target, give it a name.
It does not depend on what browser
opens it; it will open in your default

browser.
Q: Perhaps I did not make my question clear; I want to know why when I am
in Chrome and want to download a City
Bank statement, it flashes on and then
goes blank. On the other two browsers, it
opens up and downloads the statements.
A: Oh, I misunderstood the question.
I do not use Chrome, Michael does.
Michael: My guess is that you are
using an extension on Chrome. See what
you have and they should be the same as
in the other browsers.
Can’t get sound on a video
Q: Question was read: A friend sent
me a video and I cannot get sound. I
checked sound settings and volume and
everything looks all right.
A: You cannot give me this kind of a
question. What are you playing the video
in, Media Player?
Michael: Is he trying to click it on
from his e-mail? I have done that twice
this week. That is why it will not work.
Toby: It will take if you copy it to
your desktop, save it to whatever folder
you want to put it in, and fire it up from
there. When you try to open up videos,
they do not open up because they can be
loaded with viruses. What they do is
make you copy it to your desktop or your
download folder, or some other location,
and then fire it up from there. Then your
anti-virus has a chance to look it over and
make sure everything is copasetic.
Michael: If you are trying to open up
an attachment in an e-mail that was a
video — double clicking the attachment
and trying to watch it — try this: Right
click Save As or Save All, and put it in
My Documents.
Toby: A lot of the security settings we
are getting now are preventing you from
doing any thing out of e-mail directly.
The reason is that so many viruses are
included in those attachments and everyone is getting really paranoid. Do a Windows update, and what worked yesterday
does not work today.
32-, 64-bit questions on SSD
Q: On the solid state drive do you get
into 32-bit, 64-bit thing or does that go
away when you go to solid state drives?
(Continued on page 9)
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A: It has nothing to do with it. You
can install 32-bit or 64-bit, Linux, etc.
Understand that the 32-bit, 64-bit are
processor dependent, not hard drive dependent. On the hard drive is data, and
you can put that stuff on a CD or DVD or
any other media. The media does not care
what you put on it, because it is just the
system that reads it.
Connecting a SATA drive
Q: I recently found that my motherboard had some SATA connectors on it,
and that seems to be the only kind of
drive that is available now. Is there anything I need to know, except to get the
right cables, right power adaptor, to connect the SATA drive? The motherboard is
about 4 years old and has two static connectors.
Michael: Unfortunately, it really depends. You can try it, but the problem is
that the very first generation of motherboards that came out only had static connectors in RAID, an acronym for Redundant Array of Independent Disks
(formerly Redundant Array of Inexpensive Disks). You could not plug in just
one drive in the static connection. Eventually, they got rid of that and you could
plug just one hard drive into one connector and power source and you were fine.
It is hard to know without looking at what
motherboard you have. I have been bitten
by that so many times — thinking I have
two and I can use just one, but it does not
recognize just one because it wants both.
It is the way that manufacturer did the
first generation. They said, we are on the
leading edge, we are going to have SATA
and they did not do it universally. It is
more complicated than you want.
Windows 7 OEM
Q: I have a question on installing the
OEM version of Windows 7. When you
install, activate and the drive crashes and
you replace the hard drive, can you reactivate an OEM version twice?
A: You can reactivate pretty much
indefinitely. As we were discussing about
solid state drives, you could probably put
the solid state drive in and not have to
authenticate at all. The authentication
process is supposed to be based on a point

system as to how many components are
changed before they make you authenticate again, but it is presumed that one
component will not trip you up with authentication. The problem we are having
is since they started that program, everything has moved onto the motherboard.
You do not have the sound card, video
card, network card, modem and all of the
other stuff that used to be on separate
cards. It is now all on one board. If the
motherboard goes, you are going to be
calling Microsoft and be speaking to
some kind person in India.
Michael: What you said is exactly
right, if all that you are changing is your
hard drive, you should be fine. Worst
case scenario, you have to call the 800
number and say, my hard drive died and I
replaced it with another one. They will
say, OK, punch this in and you are done.
Q: Does it somehow know that it is
the same computer, like from serial numbers?
A: Every piece of equipment manufactured has what they call a MAC address (Machine Access Code) and they
are unique, no two components manufactured in the world have identical MAC
addresses. This is for hard drives, network cards, video cards, processors, and
anything in your computer that responds
to an electronic message has a unique
MAC address. That includes all of your
adaptors, wireless, all of that because they
all have unique MAC addresses. There is
an inventory of the MAC addresses stored
with your authentication in the registry.
When you start up and the MAC addresses do not match up, it will subtract
so many points, and when you lose so
many points, it sends it into authentication. The problem with motherboards is
you end up with everything being used.
Another thing is if you ever have to authenticate a motherboard, do not tell them
that you upgraded the motherboard, just
say your motherboard died and you replaced it with the closest model available
from the manufacturer. You are allowed
to do that, but not allowed to upgrade
with OEM versions of Windows, you
have to buy a new copy. To be safe, you
should use the same motherboard manufacturer.

Enabling network adaptor
Q: A quick followup on the MAC
addresses: I have run into software programs that require that a network adaptor
in your machine be enabled so that they
can read a MAC address and authenticate
against that. It was, to me, a strange thing,
and I could not get the computer program
to run, so I finally had to settle on turning
on one of the adaptors. I wanted the machine to be very high-speed machine, and
I took it off the network, and did not run
any antivirus.
A: If you have one of the older laptops, you couldn’t install that program.
They come with a network card.
E-mail malware
Q: You were talking about taking
things out of e-mails so the antivirus
could check it, what about something like
a picture inserted into an e-mail? Does it
have the same potential?
A: Someone wrote a virus that would
attach to a JPEG, but they were able to
plug that up. That we know of, there are
no vectors in any of the existing graphics
file. You should be able to preview it in
your e-mail. You can save it to your hard
drive also, but if it is a picture you want
to look at once and throw away, then look
at it in preview.
Michael: Good news, bad news. The
good news, for those of us who have to
fight viruses for a living, one of the lead
ways to get viruses is when your grandkids go on the Internet and get/share music across the Internet. Bad thing!
LimeWire has been shut down by court
order. LimeWire is no longer in business.
Now, is that the only way to get viruses
by sharing illegal music? No. It is just
the easiest and most popular on college
campuses.
How many of you heard of Adobe
Acrobat, or Adobe Flash, how many of
you know that every month there is a new
problem they find that there is a problem
with Adobe Acrobat and you get viruses?
How many of you remember last month
or saw the YouTube video on how to shut
off the problems within Adobe Acrobat
so you do not get bitten by these? Anyone
remember seeing those? How many of
(Continued on page 10)
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you have no idea what I am talking
about?
First, open up Acrobat and when
there, click Edit > Preferences > Trust
Manager, which states “allow non-PDF
file attachments with external applications.” Just think about what that sentence means. I’m in Adobe Acrobat reading a PDF file and I want to allow Adobe
Acrobat to let some other program start
opening? I have no idea what it is or have
control over it. No, uncheck that because
you do not have any reason to allow other
programs to open. When I open a PDF,
all I want is Acrobat. That is the first
thing.
The second thing is JavaScript where
it says, “Enable JavaScript,” no, and
again there is no reason why a PDF needs
to sing and dance. All I want to do is read
the PDF.
So, you will want to open up Acrobat,
go to Edit > Ppreferences > JavaScript
NO and uncheck JavaScript so nothing is
there; then in Trust Manager, no, I do not
want Adobe to make decisions for me
about other programs.
Strangest thing, Adobe is supposed to
be updating its software every quarter
because they would not have to do it
more often than that. However, they have
had to do it every month since they made
that announcement.
They have not addressed the new vulnerabilities that have been found in the
wild, there are viruses taking advantage
of them. What they recommend to do
instead is exactly the same steps that I

just showed you.
Updating Java
Q: If Java update available is in the
right corner icon, should I install?
A: Absolutely.
‘Enable global object security policy’
Q: Regarding Acrobat security,
should I uncheck “Enable global object
security policy?”
A: Absolutely not. You want to leave
your object security policy in place. It
does not do a lot of good, but some good.
Do upgrades change settings?
Q: The problem is, when I do get
these upgrade notices and I allow them to
run in Adobe, do they go back in and
recheck those things? So that every time
they do one of these background updates,
do I have to run back there and uncheck
those babies again?
A: That would be a good idea. You
definitely want to check and make sure.
The last one I did my settings were not
changed; however the one before that did.
I have no idea what the next one from
Adobe is going to do, but it is not a bad
idea to check each time.
SSD reliability
Q: I want to go back to solid state
drives. My understanding is that sold
state is more reliable, correct? If I save
stuff on an external drive would it be better to have a solid state drive and are external solid state drives available?
A: Sure. We all have them in our
pockets, they are called flash drives. It
will give you a little extra security, but
not a tremendous amount.

Practice safe computing: Back up, back
up, back up
(And then test the backup to be sure it
worked)

One of the caveats of a solid state
drive is that there is a limit on how many
times you can change the data under a
specific spot on the drive. They will wear
out after five or seven years depending on
how much data you write, but they will
wear out potentially faster than a spinning
drive that can be rewritten forever.
Michael: My experience is exactly the
opposite.
How many of you have seen those
Western Digital My Books, a little black
MyBook you plug into? Those that plug
into the computer and into the electricity
and the driver always running, literally,
physically moving constantly, 24-7. In a
solid state drive, there is nothing moving,
which means, in my experience, most of
those external hard drives die within three
years. Gone, dead.
With a solid state drive, even though
it is plugged in all the time, there is nothing spinning and so there is nothing to
wear out. The only time you wear anything out is when you are writing to
something — actually reading never
wears anything out, and only writing
wears something out. If you are storing
stuff there and want to retrieve it in 10
years and not going to use it, I think it is
safer on solid state.
Toby: In addition to being more expensive, they aren’t as big. For some of
us who have a lot of pictures, even an
80GB solid state drive is marginal. If all
you are doing is pictures, I would burn
DVDs. DVDs will be in landfills 500
years from now, unless they are badly
scratched or exposed to the sun or heat.
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Program: Browser Wars

Latest versions are ready for HTML 5
By John Weigle
jweigle@vcnet.com
oby Scott and Michael Shalkey
discussed “Browser Wars” at
the last meeting, offering their
comments on current and beta
versions of several Web browsers.
Scott kicked off the program by first
discussing HTML 5, the latest version of
HTML (hyper text markup language,
which is used to write instructions for
Web pages). The main new feature of
interest to users as opposed to page designers, Scott said, is that HTML 5 builds
in ways to display several types of multimedia material that now require add-ons
such as Flash and QuickTime to run. All
of these have been incorporated into the
new language.
It’s difficult to show HTML 5 because
the material displayed with HTML 5 and
with add-ons looks the same to the end
user, he said. Browsers that can handle
HTML 5 will not have problems showing
HTML 3 and 4, he added.
Scott discussed Firefox 4, beta 7;
Google Chrome 8 beta; Internet Explorer
9 beta; and Opera 10.6.
The latest Opera has less implementation of HTML 5 than the beta versions of
other browsers, he said.
The default opening page of Chrome
shows your most visited Web pages, he
said, but interestingly, Facebook doesn’t
show up there no matter how many times
it’s visited, he said, adding, “Google
doesn’t like Facebook.” (Shalkey noted

T

For more information
For more information about browsers,
check these reviews on the Web:
http://lm.pcworld.com/
t/1299446/5415687/141493/0
This is the site that Michael showed
as he spoke. The URL is copied from the
address bar for the article but often took
me to a new lead story. If that happens,
search for “Which Web Browser is
Best?” and find the PC World article,
which appeared on Aug. 12, 2010. It covers IE 8, Firefox 3.6, Chrome 5, Safari 5,
and Opera 10.6
h t t p : / / w w w . i n f o w o r l d . c o m/ d /
applications/the-best-web-browserchro me-firefox-internet-explorer-

opera-or-safari-516
Posted Aug. 11, 2010, the reviews
cover Chrome 5.0, Firefox 4.0 beta, IE 9
beta, Opera 10.60, and Apple Safari 5.0
http://www.pcmag.com/
article2/0,2817,2365692,00.asp
Dated June 28, 2010, this covers
Chrome 5, Opera 10.5, Safari 5, IE 9
platform preview, Firefox 3.6, and IE 8
http://internet-browserreview.toptenreviews.com
No date on the page, which covers
Firefox 3.5, Chrome (no version listed),
IE 8, Opera 9.6, Safari 4, Maxthon 2.5,
Flock 2, Avant Browser 11.7, Deepnet
Explorer 1.5 and PhaseOut 5

that Google has been losing employees to
Facebook, just as Microsoft once was
losing employees to Google.)
Internet Explorer 9 and Chrome —
but not Opera and Firefox — have builtin cloud office suites along with storage
space in the clouds, he said. Cloud computing means that programs are on a Web
site and used through the browser and
documents are stored on space on companies’ servers rather than on a user’s hard
drive. Lots of people expect Chrome to
win this part of the browser war, with
Firefox and Microsoft fighting over the
rest, he said.
Facebook has just announced a new

messaging system that some people say
might replace e-mail. More information
on that can be found at http://
w w w. m e r c u r y n e ws . c o m / b u s i n e s s /
ci_16642425?nclick_check=1
Young users use Twitter and texting
to communicate, and that information will
be kept on Facebook pages, so users will
need Facebook accounts. “They announced the product, but there’s nothing
really there yet,” he said.
All the browsers have some kind of
preview screen, he said. Opera was the
first browser to offer such a feature and
calls its version “speed dial.” The default
(Continued on page 12)

More Command.com ...
www.ftc.gov/bcp/edu/pubs/articles/
naps07.pdf offers these tips:
Use a credit card.
A related site lists rules for using your
Verify whom you are dealing with.
credit cards.
Try to get a physical address and phone.
http :// www. safeb o r ro wi n g.co m/
Know exactly what you are buying.
creditcards/using.shtml
Comparison shop.
Tips include: Check the terms when
Check the privacy policy.
the card arrives, and what to do when
Do use a credit card. Never send cash,
your credit card company changes their wire transfers, etc.
terms (you can often “opt-out”).
Use secure browsers and transactions.
And finally, the FTC at http://
Consider the shipping and handling

(Continued from page 1)

costs.
Print records of your online transactions.
Understand the return policy.
Check delivery dates.
If you feel you have been misled or
deceived, a complaint can be filed at
ftc.gov (although you should always attempt to settle disputes first).
Happy computing!
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Other categories
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Classified ads are free to
members. Each ad is limited
to 105 characters, including
spaces and to one ad per
member per month. Copy has
to be to John Weigle, editor of
TOE (editor@cipcug.org),
within the week after the
regular meeting. Otherwise,
the ad is held to the following
month.

Wanted
Wanted for AARP Free
Income Tax program: Laptops
running XP or XP Pro 500+
MB memory, 20+GB hard
drive. — Art Lewis
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More on Browser Wars ...
(Continued from page 11)

view is three rows by three columns, but this can be changed for
people with wider screens. Users manually insert the nine pages
they visit most often. Firefox defaults to a Google search, but
there is an Extension that more or less copied “speed dial.” The
beta also lets users create groups of related sites by opening a
page and using a group button on the right of the toolbar. “It
works really nicely if you do a lot of things,” Scott said, adding
that he uses grouping for Lions-related sites, CIPCUG-related
sites, Web page design work and office projects, among others,
he said.
All the browsers are orders of magnitude faster at loading
Java Script than earlier browsers, so “we’re talking about huge
speed differences in rendering pages,” he said. Of the production, as opposed to beta versions, Opera is by far the fastest, he
said, but added the browsers leapfrog each other as new versions
are released. Opera also has the fewest vulnerabilities and is the
most standards-compliant of all the browsers. It has about 1,000
widgets, fewer than Firefox, along with an icon creator. “They
have some fairly interesting widgets, and have a lot of them,” he
said.
The latest Firefox beta, along with other browsers, uses the
Alt key to hide and show the menus. Almost none of the standard Firefox add-ons work in the beta version yet, but some
10,000 are available for the production versions and tend to be
updated as necessary as production versions are released. To
search for Firefox add-ons in the browser, go to Tools > Addons or use a search engine to look for “Firefox add-ons” and
what you want to find. Mozilla includes users’ ratings of addons, and Scott said anything with three stars is problematic; the
top ranking is five stars.
As he has at several earlier meetings, Scott strongly urged
users to install NoScript in Firefox to prevent unwanted scripts
from running on Web pages.
Firefox is often slower to load than other browsers, especially if you use lots of add-ons, he said, but “once it’s running
it’s one of the fastest” and is the most configurable. It has an
FTP (file transfer protocol) add-on, one to edit cascading style
sheets for web pages and several coding authentication add-ons.
Add-ons for Facebook and Twitters are also available. Three
versions of IE Tab — IE Tab, IE Tab Plus and IE Tab 2 — are
available, he said. If one doesn’t work in the Firefox version you
use, one of the others should. The program lets Firefox display
pages that are designed only for IE.
Chrome has a number of add-ons and extensions, he said.
Internet Explorer does not offer either.
Shalkey commented that the goal of users is to go to a site
and have fun. You don’t go to a browser, he noted; it takes you
somewhere, so the goal is to find one that works well for you on
your machine.
Scott said that HTML 5 cuts the number of vulnerabilities
available to hackers without having to worry about Flash and
similar software.
Shalkey said that his experience with the Apple Safari
(Continued on page 13)
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browser is that people who want to use it
should get a Macintosh. “Don’t even try
to use Safari on a PC,” he said.
He discussed a PC World comparison
of production browsers that reviewed the
interface, security, extensions and addons, speed and performance. Its winners,
by category:
User interface: Chrome
Security: Chrome
Extensions and add-ons: Firefox
Speed: It says most page-loading
speed claims are overblown. It says that
Chrome has the best JavaScript handling
and page loading but that the difference
in this category is almost negligible.
Shalkey said that those using any version of Internet Explorer should upgrade

to version 8 now and stop using versions
6 and 7 because Microsoft is not going to
keep fixing their security problems.
“If you’re in a beta you’re in a new
universe,” Shalkey said, and it can be
difficult to get help with problems. Beta
versions of software are distributed for
testing and use by as many people as possible to find and fix problems before
they’re released as production versions.
Scott commented that the article
Shalkey cited were for current production
versions of the browsers and not the betas. When the betas go final, there will
almost certainly be changes.
Shalkey said that the computers being
used five years from now will be far different than those we use today. Lots of
kids are not using computers but rather

cell phones and similar items. “They want
the future, and the future is called RockMelt,” he said. It’s so new that you have
to be invited to even test it.
Laptops, especially, will be cloudbased, although not everyone will go that
route.
A member of the audience commented that some areas can’t even get
DSL connections and cloud computing
will be impossible for them.
Scott agreed, adding that many jobs,
such as data entry and graphics editing,
are likely to remain on desktop computers.
Other people will have privacy and
security concerns. But cloud computing
will be good for such public computers as
those in libraries, he said.

    
Beware of messages purportedly from your bank, PayPal or other financial sites asking for personal
information, such as your login name, password or Social Security number.
They are likely to be from scammers who hope to empty your bank account. If in doubt, go to the site of
the institution by typing in a known URL, not by clicking on the e-mail link, and look for messages there.
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The big four browsers: another look
This material is reprinted, with permission, at the suggestion of Bob de Violini, who writes our periodic security column. It is from OUCH!, the SANS Institute Security Newsletter for Computer
Users.
Get security advice online at
http://www.sans.org/newsletters/ouch/
updates. — Editor

[E

ditor's Note: (Wyman) This
month we look at the buzz
and some measurable security
merits of the Big Four browsers: Internet Explorer, Firefox, Chrome,
and Safari. Browser Wars are a competition for market share. (1) The fighting is
about speed, add-ons, graphics, and the
user interface. Every now and then a pronouncement about security gets tacked on
to the discussion, as an afterthought: “It’'s
better, and safer, too.”
Despite its second billing, your
browser is the most likely pathway
through which malware will attempt to
enter your computer. It’s important to use
the latest version, keep it patched, and be
judicious about the websites you visit.]
Internet Explorer
IE has the distinction of being the
most patched browser in history. It’s a
dubious one perhaps, but any software
application that’s been around for 15
years and is still in daily use on 60 percent of all computers worldwide can’t be
all bad. (1) IE has many reputations ranging from the stolid “enterprise browser,”
to a stodgy hodgepodge of stale graphics
and ho-hum functionality, to a typical
Microsoft product riddled with security
holes and bugs. Is IE’s security
“inherently flawed?” That’s debatable.
Certainly arguments about the security of
IE’s ActiveX vs. the-rest-of-the-world’s
Java have simmered — and occasionally
flared up — for the last 13 years. But
there’s no debate that, thanks to IE’s huge
market share and unequaled longevity, IE
users are the biggest target for malware
and the Bad Guys.
Firefox
Mozilla products hold a special place
in the hearts and minds of users who got
to know e-mail using Eudora and the

Web using Mosaic or Netscape.
For some, Firefox, Netscape’s successor, is the nonprofit, open-source, crossplatform, righteous opponent of Microsoft’s corporate, monopolistic, propriety,
Windows-only Internet Explorer. When
Microsoft abandoned Internet Explorer
for Macintosh in 2003, Mac users were
disenfranchised in one fell swoop; Firefox 1.1 and Safari came to their rescue.
More urban legends surround Firefox
than any other browser; there’s a whole
website dedicated to debunking Firefox
“myths” (2).
Firefox's market share grew rapidly in
2009-10 as it became the “other browser”
of choice among Windows users (3).
Chrome
Chrome entered the browser competition in late 2008, ushered in by Google’s
trademark air of confidence and uniqueness, like a third party presidential candidate touching down in a traditionally
Blue-Red state.
Originally a Windows-only product,
Google adopted an open-source strategy
that made it possible (and legal) to incorporate components of Firefox and Safari
into a stable Mac version which was released in May 2010. Chrome’s market
share, flat for the preceding eight months,
began an upward trend at the same time
that the Mac version was released (3).
If Firefox is the “other browser,”
Chrome is the “other other browser,” set
apart by its spare, uncluttered user interface, and the promise of a different kind
of user experience. Chrome’s superior
security has been touted, but owing to its
newness and relatively small market
share, Chrome has not participated in the
trench warfare of the Web yet on the
same scale as the veteran IE and Firefox.
Safari
Safari is the only browser that began
as a Mac-only product (in 2003).
Today Safari is included in every version of OS X. The Windows version was
not released until mid-June 2007 and has
never been included in any version of
Windows. Safari for Windows' market
share remains at less than 1 percent, making it the least popular of the browsers
mentioned here.

This may explain why Apple’s security support for Safari for Windows has
been so dismal. Safari 5.0 for Mac, on the
other hand, is the most familiar and popular browser among Mac users. As with
Internet Explorer and Windows, Firefox
is the “other browser” among OS X users.
Apple security support for Safari has improved since the release of Mac version 5.
Security metrics
According to Symantec’s April 2010
Internet Security Report (4), in 2009 IE
garnered 45 reported security flaws, on
par with the 41 flaws reported for
Chrome, considerably out in front of Safari and its 94 flaws, and way ahead of
Firefox’s 169 flaws. Contrasting stats are
available from US-CERT’s National Vulnerability Database (5), which for a recent three-month period tallies 17 reported vulnerabilities for IE, followed by
Firefox with 20, Chrome with 40, and
Safari with 51.
The appearance or emergence of
browser flaws and vulnerabilities is inevitable. From a practical standpoint, what
matters as much, if not more, is how
quickly they get patched; that is, how
long what the Symantec Report calls a
“window of vulnerability” remains open.
For 2009, that was on average less than
one day for IE and Firefox, two days for
Chrome, and 13 days for Safari.
Recommendations
Kudos to Microsoft and Mozilla for
responding quickly to vulnerabilities as
they are discovered in Internet Explorer
and Firefox, and for developing fast and
effective ways to deliver patches to your
computer automatically. Their makers
have demonstrated consistent concern for
your security and have a proven record of
standing behind their products.
Brower security tips
● The security of any browser can be
undermined if you tinker with or turn off
its security features, or browse the Web
indiscriminately.
● Keep your browser version up-todate. New versions are free for the
downloading. (6)
● Security patches and updates are no
(Continued on page 15)
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Rescuing your PC using Linux
By Bill Wayson
bwayson@gmail.com
his month’s topic is based on a
suggestion submitted by Bob de
Violini — thanks, Bob — and
an article written by Katherine
Noyes that appeared in Computerworld
online.
Occasionally a Windows PC just dies.
It won’t boot, won’t run anything, or just
doesn’t run correctly.
Penguin’s
The PC may really be
Lair
dead. But it may have
become so messed up,
either through malware,
or hardware or software
problems, that it is just
not usable. What to do?
If other remedies, such
as Safe Mode, do not
work, you may want to
use Linux to fix it.
Wayson
Here’s how.
If your PC powers up but otherwise
doesn’t run correctly, it could be infected
with malware or have some piece of hardware that is failing. Linux can help you in
these situations. You run Linux from a
live CD or USB drive, fix the issue or
copy your personal documents somewhere safe, replace hardware as neces-

T

sary, and then return to running Windows. Because of its popularity and easeof-use, we will describe the use of an
Ubuntu installation CD. Using a PC that
has access to the Internet and a free gigabyte or so of storage (Note: You may
want to do this while your Windows PC
is healthy), go to the Ubuntu home page
at www.ubuntu.com. Click the Download
Ubuntu button. Your download options
should be set to the latest version and 32bit (which will also work in 64-bit x86
systems). After pressing Start Download,
you’ll receive an .iso file. When complete, use your favorite software to burn
the file to a CD (rewritables work great)
as an image, then store it away safely.
When the fateful day arrives and your
PC takes ill, power it on, open the CD
tray and insert your Ubuntu disc, and, if
necessary, reboot the PC. You may need
to make adjustments in your system configuration to enable booting from a CD
and to place CD drives ahead of hard
drives in the boot order. You’ll know
Ubuntu is booting when you see
“Ubuntu” in the middle of your screen.
Shortly you will be presented with two
option buttons asking you to try or install
Ubuntu. Select Try Ubuntu to allow the
boot to complete at the main Ubuntu

desktop. Once you see it, congratulate
yourself — you are running Linux. Note
that running an operating system from a
CD or USB stick is much slower than
running it from a hard drive. Have patience as you wait for operations to complete. Then, let’s get to work.
If you need to copy documents because, say, the hard drive is failing, just
plug any USB hard drive into the PC. An
icon representing the USB drive will appear on the desktop and a file manager
window should appear displaying the
contents. The vertical pane on the left
displays, among other things, all of the
hard drives in your system. Right-click
your mouse in the right pane to bring up a
menu that presents the option of creating
folders. First, select the File menu, then
New Tab to create a new window tab.
Select your Windows disc on the left to
see its contents. Now you should be able
to copy any files and folders you want
from your Windows tab to the tab representing your USB drive. When you are
finished, close the file manager by clicking the red “X” in the upper left of the
title bar. Now right-click the desktop
USB drive icon and choose Unmount.
After the icon disappears, you can detach
(Continued on page 16)

More on browsers ...
(Continued from page 14)

substitute for installing and maintaining
good-quality anti-virus or a multicomponent security suite on your computer.
● Keep your software firewall turned
on.
● If you are not sure about your firewall, or think your browser is acting
funny, take a cautious approach and have
it checked out promptly by IT at the office or by your computer consultant.
Notes
(1) http://www.netmarketshare.com/
browser-market-share.aspx?qprid=0
(2) http://home.co mc ast.net/
~SupportCD/FirefoxMyths.html
(3) http://www.netmarketshare.com/
browser-market-share.aspx?qprid=3

( 4 ) http :/ /e val. s y ma nt e c.co m/
mktginfo/enterprise/white_papers/bw
h
i
t
e
paper_internet_security_threat_report_xv
_04-2010.en-us.pdf
(5) http://web.nvd.nist.gov/view/vuln/
search
(6) IE: http://www.microsoft.com/
windows/internet-explorer/default.aspx
Firefox: http://www.mozilla.com/enUS/firefox/update/
Chrome: http://www.google.com/
support/chrome/bin/answer.py?
hl=en&answer=95414
Safari: http://www.apple.com/safari/
download/
Copyright 2010,
(http://www.sans.org)

SANS

Editorial Board: Bill Wyman, Walt
Scrivens, Phil Hoffman, Alicia Beard,
Alan Paller
Email: OUCH@sans.org
OUCH! Security Information Service:
http://www.sans.org/newsletters/ouch/
updates/
Download the formatted version of
the OUCH!: https://www.sans.org/
newsletters/ouch
Permission is hereby granted for any
person to redistribute this in whole or in
part to any other persons as long as the
distribution is not being made as part of
any commercial service or as part of a
promotion or marketing effort for any
commercial service or product. We reInstitute quest that redistributions include attribution for the source of the material.
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Get faster performance in Windows 7
By Jeff Levy
This lesson is copyright by Jeff Levy
and reprinted with permission. All of his
more than 400 lessons for both the PC
and the Mac can be found on his Web
site, jefflevy.com.
s pretty to look at as Windows
7 is, all that glitter comes with
a cost — a cost in
performance. Dump some of
those bells and whistles and you get faster
performance.
For example, the shrink or grow that
you see when you minimize or maximize
a window looks really good, but do you
really need it? No, you don’t, and by getting rid of that feature things will start
happening faster on your screen when
you perform such operations.
To disable it, click on start and then
open the control panel. Now open the
System and security icon and then open

A

Security link. Next, click on the
Advanced system settings link on the left
hand side of your screen.
In the Performance section click on
the Settings button. Now
Learning
with Levy click in the small circle to
the left of Custom and
then click to remove the
check mark next to Animate windows when
minimizing
or
maximizing. That’s it —
LEVY
you’re done.
Note that there are 20
options here — each with a check mark
next to it to enable it. The more
checkmarks you remove, the faster Windows 7 will perform. Remember that
there’s a balance here — you give up the
graphic look of Windows 7 in exchange
for better performance.
“Jeff Levy on Computers” can be

heard at 7 a.m. every Sunday on KABC,
790 AM. Jeff’s notes for every show are
at www.jefflevy.com. Click on Show Notes
on the opening page to access a wealth of
information.
Jeff has added an additional project
to his list of tasks: Snapshot Talk Radio,
Your Eye on the World of Photography.
The
Web
site
is
http://
www.snapshottalkradio.com. Jeff cohosts the program with Timothy E.
Goodwin, The Photo Professor. The
website's pages are Home, About the
Hosts, Tim's Gallery, How to, Ask Jeff &
Tim, Cameras, Printers, Accessories,
Show Notes, Pod Casts and Show
Information.
The website says the show is on the
following stations: Los Angeles (KABC –
AM), San Francisco (KNEW – AM),
Seattle (KVI – AM) and Salt Lake City
(Freedom 570 – AM).

More on Lair ...
(Continued from page 15)

the USB drive, shut Ubuntu down by
clicking the top panel icon to the extreme
right, retrieving the CD when it ejects,
and letting the PC power off.
If you suspect malware has infected
your PC, you can scan for and remove it.
First we need to install some virus scanning software — we shall use ClamTK.
From the Ubuntu desktop, select the Applications menu and then Ubuntu Software Center. From the Software Center
window, select the Edit menu and then
Software Sources. The Ubuntu Software
tab should already be selected in the Software Sources dialog. Under the heading
Downloadable from the Internet, make
sure the four top boxes are checked
(Software Sources can be unchecked) and
click Close. Back at the Ubuntu Software
Center window, ensure that Get Software
is selected in the left pane and click on
the Accessories icon in the right. Type
ClamTK into the search box. One result
will be shown as Virus Scanner — More
Info will verify it’s the right package.

Click Install and have some tea while it
downloads. Once installation is complete,
we need to download the latest malware
signatures. From the main Ubuntu desktop, select the Applications menu, then
Accessories and Terminal. In the terminal, type in “sudo freshclam” and press
Enter. Enjoy more tea while the signatures are installed. Dismiss any messages
warning of low disk space and any complaints that something could not be copied or saved. We are most interested in
the main signature file. Type in “exit” and
press Enter when freshclam is finished.
To launch ClamTK select the Applications menu in Ubuntu’s main desktop,
then Accessories and Virus Scanner.
When the ClamTK window opens, select
the Scan tab and then the option for a
Recursive Scan. Next, select your Windows drive in the left pane and click OK.
Scanning may take some time, so warm
up your tea. If infections are found you’ll
get a dialog with a list of them. Rightclicking one presents the usual options for
what to do with it, including quarantine

and removal.
Once the infections have been removed, your computer should be clean.
You can remove the CD or USB drive
and boot back into Windows as usual. As
you use your rescued PC once again, remember that it’s all thanks to Linux and it
didn’t cost you a cent. Safely store your
CD or USB away so you’ll be ready for
the next emergency.
If you have questions or would like to
learn more about Linux and FOSS, come
to the December CIPCUG Linux SIG
meeting at 6:30 p.m. on Tuesday the 21st
— note that this is the third Tuesday of
the month — at Ventura County Computers in Ventura. Unless I get ahold of it
first, the CIPCUG PC should complete its
upgrade to Ubuntu 10.10. While that is
running, we will have another PC we can
use to discuss PC rescues and try to answer all of your questions.
If there is something you would like
the Lair or Linux SIG to cover, drop me a
line at bwayson@gmail.com. Until next
month, happy computing.
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Word and Excel tips
Word: Inserting the template name in your document
Every Word document has a template attached to it. Depending on your version of Word, this template
defines things such as your menus, toolbars, macros, and styles (among other things). If you do not explicitly attach a template, then Word uses the Normal template.
The name of the template file attached to your document can be inserted into your document and updated automatically. To do this, follow these steps:
1. Position the insertion point where you want the template file name to appear.
2. Display the Field dialog box. (In Word 2007 or Word 2010 display the Insert tab of the ribbon and
then choose Quick Parts | Fields from the Text group. If you are using an older version of Word, choose
Field from the Insert menu.)

The Field dialog box.

3. In the Categories list, choose Document Information.
4. In the Field Names list choose Template.
5. Click on OK to close the dialog box and insert your field.
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word
tips can be found online at http://word.tips.net.

Excel: Using the CONCATENATE Worksheet Function
Excel provides a function called CONCATENATE which can be used to combine the contents of several
cells, or even to combine cell contents with other text. For instance, let’s say you wanted to add together the
(Continued on page 18)
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Green PCs: Your best bets

ʼT

was the night before
Christmas, and all through
the house, not a creature
was stirring, not even a

mouse.
That’s because they just bought a
green PC. That’s right, folks, everybody’s
on a marketing scheme to promote green
PC components. Everything from operating systems, CPUs, mainboards, power
supplies to hard drives. Almost anything
that goes into a computer
Rick’s
can come with a “green”
rant
marketing ploy. The official Green-PC components
are supposed to be leadfree. The real rub on all of
this is being GREEN is a
good idea and can have
real benefits such as reducing yearly power conSmith
sumption and less lead in
our landfills, but it can
also cause unneeded computer problems.
If you look online, you find no end of
complaints about Western Digital’s green
hard drives. Drives which power down
when not being used but can also cause
data loss problems and systems hangs.
Western Digital makes four basic levels
of mechanical hard drives, Green, Blue,
Black and RAID. Green I refuse to sell as
I have to fix everyone’s problems and the
fewer I have the better. Blue is my preferred choice for value and price. With up

to 16MB cache it’s a solid performer.
Black is all speed and performance with
32MB cache, and it’s the right choice for
high-performance users. Western Digital
also makes RAID drives under its black
label. Most users don’t realize that even
though you can RAID any hard disk it is
highly recommended to use the RAID
series specification. There are slight differences in the drives’ electronics that
make them reliable pairing them up with
one or more additional disks.
One of the trends in today’s PC market is the move to a smaller form factor.
You can see the evidence in netbooks and
also hand held devices that are becoming
more PC-like. Granted, miniaturization is
lower power consumption and less power
usage. But it also makes servicing it more
difficult and costly. Intel basically makes
three types of desktop motherboard footprints: ATX, full size; Micro-ATX, medium size; and mini-ITX. small size.
While all have their uses, I prefer to sell
the Micro-ATX line as my first choice.
Intel’s Mini-ATX line has all the features
and functions of the full-size ATX boards
as long as you get the media or extreme
series. When you purchase one of the less
featured Micro-ATX mainboards you will
find only two memory slots, compared to
four on the nicer ones. I still like to put
these in a full-size case as the better air
flow helps keep everything cooler. There
is also the added advantage of being able

to get to everything easily. The smaller
the PC, the more work it is to remove any
given part of it. There is also a type of
mini PC out there that uses more of a
notebook motherboard with SODIMM
notebook memory. I sold six units to a
good client a few years back and even
though they were brand name PCs two of
the motherboards had to be replaced.
They were called book-shelf PCs. All the
small form factor PCs, including the ones
shaped like little shoeboxes, use a custom
power supply. These small power supplies seem to have a much higher failure
rate than full-sized ATX power supplies.
Also be prepared to wait to have one
shipped to you as most vendors do not
stock them as they are too specialized.
Some can be a bit expensive, too. But,
hey, if you have only a small space to
work with, they can still be an excellent
choice for you, but they are not my first
recommended choice in form factors.
It used to be a big debate on whether
to let your PC run constantly or to manually shut it down when not in use. This
argument has lost much of its gas due to
the power efficiency built into today’s
operating systems. Windows will allow
you to aggressively set the power settings
to virtually shut down your PC when it
detects lack of use and then quickly resume where you left off. My neighbor has
a MacBook Pro that I don’t think he’s
(Continued on page 19)

More Word and Excel tips ...
(Continued from page 17)

contents of cells A3 and B3, separate them by a space, and have the result appear in cell C3. All you need to
do is put the following formula in cell C3:
=CONCATENATE(A3," ",B3)
Primarily, the CONCATENATE function is used for compatibility with other spreadsheet programs.
You can just as easily use the ampersand (&) operator to combine text values using a formula. For instance,
the following is equivalent to the example of CONCATENATE shown above:
=A3 & " " & B3
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online at http://excel.tips.net.
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We’re meeting on third Saturday again
By Helen Long
helen@cipcug.org
on’t forget, we meet on Dec.
18, the third Saturday, this
month.
Our program in December
will be Toby enlightening us on OneNote
and Michael showing us some of the new
computer toys or Christmas presents this
year.
The price has been raised for those
wanting the newsletter only; the new

D

price is $20 annually.
Bits & Bytes
Our award-winning
newsletter is packed
with useful information.
The Q&A alone is worth
the $1.67.
We have decided to
have another computer
tuneup in January. The Long
price is $15, and Rick
and Michael will check your computer to
see if there are things you can do to speed

it up or let you know if you any serious
viruses. If they are unable to repair the
problem due to time constraints, they will
give you the $15 as a discount when you
takeg your computer in to their office.
We have decided to rename our Early
Beginners Group Meeting from Computing 101 to “Hands on Computing.” Jessica Scott and Mike Maidel share in this
workshop type meeting.
HAVE YOU RUN YOUR ANTISPYWARE PROGRAMS LATELY?

More on Rick’s rant ...
(Continued from page 18)

ever shut off. He just closes the lid, and it
powers down and when he lifts the lid, it
just powers up magically. Oh, if only I
were an Oscar Meyer Mac. That is truly
what I want to be. Nonetheless, the
standby and hibernate features on computers have really improved in recent
years with better hardware and software.
So this is one green idea I can get behind.
What about LCD screens? Here’s
what CNET has to say about that.
“Conserving power can save you
money: The less power your monitor
pulls, the lower your monthly electricity
bill. How much lower? That depends on
two key factors. The first is how often
you use your monitor; not necessarily
sitting in front of it, surfing the Internet,
gaming, or editing a spreadsheet, but simply how often your monitor is on and
showing a picture. The second factor determining how much you’re going to save
is your monitor’s brightness setting,
which controls the luminance of your
monitor’s backlight. The lower you set
your brightness, the less power you'll use.
“How do I conserve monitor’s energy?
“Sleep mode is your friend: Make
sure that when you’re not in front of your
monitor, the device is resting up. You can
set up sleep mode in Windows by going
to Control Panel and choosing Power
Options. Select the Power Schemes tab
and under Plugged in, change the “Turn
off monitor” field to whatever time suits
you. (We recommend at least 5 minutes
to avoid your monitor nodding off while

you’re reading a long article.)
“Turn down your brightness:
Luminance is one of the most important
attributes for determining how much
power a monitor pulls, and is usually referred to as “Brightness” in your monitor’s onscreen display. Adjusting a monitor’s luminance affects the amount of
light emitted by its backlight. In our tests,
we’ve found that brightness trumps every
other setting for saving power; monitors
drew the same amount of power whether
we were playing a game or watching a
Blu-ray movie, as long as the brightness
setting was consistent.
“You may be wondering how contrast
fits into all of this. Truth is, it doesn’t.
Because the contrast setting only controls
the monitor’s white level and has nothing
to do with the backlight, it doesn’t have
an effect on power consumption.
“If your monitor has a switch, use
it : Most LCD monitors do not turn completely off when you press the power button and are still drawing some amount of
power. To ensure your monitor is not
drawing power, click off the power
switch — usually found on the underside
of your monitor, near its connection options — if you have one. The power
switch acts as an additional level of
power conservation. If the power switch
is on, the monitor can be turned on by
pressing the power button; however, if
switched off the monitor can't be turned
on — even by the power button — unless
the switch is turned back on.
If you’re going to be away from your

computer for a day or more and your
monitor doesn’t have a switch, unplug it
from the wall to make sure it’s not sucking power.”
Now what about those of us still using
a CRT? How much money do we save by
switching to an LCD? Here’s what CNET
has to say on that question.
“… Tthe approximate cost of using
the LCD 24 hours a day is $3.74 per
month. If you use this device for three
years, the extended power cost for the life
of the device would be $134.78.
“By comparison, if you had a CRT
device consuming 90 watts with the same
usage requirements, its monthly power
consumption would be $6.48, and its
three-year usage cost would be $233.68.
So simply using the LCD device for the
same requirement over three years of 24hour usage would give a savings of nearly
$100. In locations with high energy costs
(such as California), this savings can exceed $130 over the three-year term
(assuming a $0.14 rate).”
You also have to consider that these
calculations assume the monitor is running 24 hours a day, which mine isn’t.
It’s more like two hours. So that puts my
power savings down to less than $10 over
three years.
So there you have it. Granted, the
numbers can be adjusted depending on
the type of screen, but you get the point.
As for me, I use a 50-inch LG Plasma TV
at home for my PC — and I’m afraid to
look up its power consumption. It gives
(Continued on page 20)
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Smart Computing tips
and fun facts
Reprinted with permission from Smart Computing. Visit
www.SmartComputing.com/Groups to learn what Smart Computing can do for you and your user group!
Take a shortcut in Excel: If you use Excel frequently,
you’re probably already familiar with many basic Excel keyboard shortcuts. However, there are some little-known shortcuts
that can help you work even more efficiently in selecting ranges
and moving around a worksheet. For example, you can quickly
select an entire data region (a range of data cells bordered by
empty cells) by clicking one of the cells and then holding down
CTRL-SHIFT-* (asterisk). Another way to select a data range is
to place your cell pointer in the range and then press CTRL-A;
press CTRL-A a second time to select the entire worksheet. You
can also press CTRL-Spacebar to select the column where your
cell pointer is located. Another helpful keyboard shortcut is to
press END followed by an Up, Down, Left, or Right arrow key
to efficiently move the cell pointer to the outermost edge of a
data range.
Skip a bullet or number in Microsoft Word: There can be
times when you’re working with a bulleted or numbered list
when you want to add a new line without tacking on a number or
bullet. Perhaps you want to add a parenthetical note below an
entry without making it part of your list. If you hold SHIFT and
press ENTER, Word will add a new line to your list without a
bullet a number. When you want to resume numbering or bulleting, don’t hold the SHIFT key any longer.
Save the page: If you’re using Internet Explorer and you
come across a Web page with information you want to preserve,
there are two good ways to keep the information without having
to use a Web browser to bring it back up. The first and simplest
way is to print it; it never hurts to have a hard copy of information you need. Another method is to save the Web page as
an .MHT (Multipurpose Internet Mail Extension) file, which is
essentially just a snapshot of the page. In this format you can
send the page to others or double-click on it to open it directly.
To make an .MHT file from a Web page, click File (press the
ALT key to reveal the File menu if you don't see it), click Save
As, and in the dialog box be sure to select the .MHT file type.
Tell the computer where to put the file and click Save.
To ensure CIPCUG receives credit for new subscriptions and
renewals, always subscribe and renew using the Subscribe or Renew
Today! feature available within the User Group portion of the Smart
Computing Web site. From here, select us from the drop-down list
provided to ensure we received credit for the subscription order. You
can also call 800-733-3809 to subscribe or renew and give us credit by
telling the representative you want us to receive credit for the order.
Following these instructions will ensure that we get as many free
subscriptions as we possibly can.
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Treasurer’s
report for
October 2010
By Art Lewis
treasurer@cipcug.org
10-1-2010 through
10-31-2010
Category Description
INFLOWS
Coffee income
Donation
Membership Income
New members 40.00
Renewals
158.00
TOTAL MEMBERSHIP
Raffle
Software sales
TOTAL INFLOWS

198.00
-95.62
120.00
256.43

OUTFLOWS
Rent Paid
TOE
TOTAL OUTFLOWS

150.00
374.27
524.27

OVERALL TOTAL
Unrestricted Funds
Restricted Funds
Bank Balance 10-31-10
Year to Date Income
Year to Date Expense
Net Year to Date

Lewis

10.05
24.00

-267.84
7,398.11
0.00
7,398.11
1,991.40
1,698.55
292.85

More on Rick’s rant ...
(Continued from page 19)

off a lot of heat, and I know with plain physics it takes a lot
of electricity to generate all that extra heat.
There you have the ins and outs of going green. So my
best recommendation is to show your local PC builder some
of that green and get a new power-saving PC. I’m not saying
it will pay for itself, but you sure will enjoy it.
Merry Christmas, Happy Hanukkah and Happy New
Year, Enjoy the reason for the season and God Bless you all
and to all a good night. See you next year.
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November 2010 renewals payment due:

Membership report:

Is it time to renew?

Mbr# Last Name

First
Name

Pd to Dt

0388

Armstrong

Bob

201011

1061

Churchyard

Martha

201011

0635

Godwin

John

201011

0945

Gorelik

Donn

201011

1212

Hollander

Gary

201011

0905

Knauer

Hedy

201011

0789

Knauer

Wolfgang

201011

0542

Salisbury

Wayne

201011

1194

Tsutsui - Trujillo

Sandy

201011

0863

Zapf, D.P.M.

Michael

201011

By Ken Church
email address: membership@cipcug.org

Welcome New Member: Bill Wishon

CHURCH

Attendance at the November 2010 general meeting:
60 members and guests
Total membership: 197

MEMBER RENEWAL INFORMATION
$30 for single membership,
$35 for two or more family membership.
NEW MEMBER INFORMATION
$40 first year for single membership,
$55 first year for two or more family membership in same household.

December 2010 renewals payment due:
Mbr# Last Name

First
Name

Pd to Dt

Please send your payment to:

1044

Cohen

Jerry

201012

CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354

0908

Cronin

Richard

201012

1130

Hollingsworth Don

201012

0993

Ladd

Craig

201012

1115

Nagy

Marlene

201012

1131

Richardson

James

201012

1079

Schrum

Jerry

201012

1048

Ulam

Frederick

201012

Or bring your payment to the sign in table for
the Dec. 18, 2010, meting.
October 2010 renewals payment due:
Last Name

First
Name

Pd to Dt

1224

Alexander

Doug

201010

1049

Duncan

Gerald

201010

0990

Mehr

Steve

201010

0942

Mickey

Barbara

201010

1165

Taggesell

Bernice

201010

Mbr#

Page 22

The Outer Edge

December 2010

Initials
BDV

Name
Bob de Violini

(805)
rjddev@gmail.com

BR

Bill Robinson

389-2997 (b)
bill@bzus.com

DM

David Minkin

469-6970 (cell);
484-2974 (home);
dddave@cipcug.org

MS

Michael Shalkey mshalkey@cipcug.org

RP

Robert Provart

498-8477 (b)

Phone: (d) = days; (e) = evenings; (b) = both

F1—Your Help Key
(Revised Sept. 7, 2008)
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM
DATABASES
Access

BR

DOS

RP

E-MAIL
Outlook
Outlook Express
Thunderbird

MS
BR, DM
MS

GRAHICS PROGRAMS
IrfanView
Paint Shop Pro
Photo Shop Elements
Print Shop

MS
DM
BR
BR

SPREADSHEETS
Microsoft Excel

DM

WORD PROCESSING
Microsoft Word
WordPerfect

DM
DM

WINDOWS
Windows 98, 95
Windows 2000
Windows XP

DM, MS (98)
BDV
DM

If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to editor@cipcug.org.
........................
WEB HELP SITES
Annoyances Central blog (from authors of the O’Reilly
An n o ya n c e s s e r i e s , i n c l u d i n g S t e v e B a s s ) :
www.annoyancescentral.com
Steve Bass TechBite Newsletter: www.techbite.com
DSL reports: www.dslreports.com
Steve Gibson: www.grc.com
Kim Komando: www.komando.com
Leo Laporte: www.leoville.com
Jeff Levy: www.jefflevy.com
Linux distributions: www.DistroWatch.com
Microsoft: www.microsoft.com
Microsoft Windows XP The Official Magazine (UK):
www.windowsxpmagazine.co.uk
Microsoft Windows Vista The Official Magazine (UK): /
www.windowsvistamagazine.com/US
Online safety tips: www.OnGuardOnline.gov
PC Pitstop: www.pcpitstop.com
PC World: www.pcworld.com
Recalled products: www.recalls.gov
SANS Institute — Computer Security Education and
Information Security Training: www.sans.org
Smart Computing: www.smartcomputing.com
Spyware Warrior: www.spywarewarrior.com
User Group Relations (Gene Barlow): www.ugr.com
Ventura County Computers (Rick and Toby’s shop):
www.vccomputers.com
Virus Bulletin: www.virus-bulletin.com
Windows Secrets: ww.windowssecrets.com
ZD Net spyware blog: www.blogs.zdnet.com/Spyware
If you have a favorite help site on the Web, please forward
it, so we can expand the section. If you find a link that
doesn’t work, please tell us that, too.
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Why join Channel Islands PC Users
Group (CIPCUG)?
Every month, members of the Channel
Islands PC Users Group have access to:
♦ The Outer Edge newsletter, which
includes a list of members willing to help
other members.
♦ The general meeting, featuring a
question-and-answer session and program
on new software or hardware.
♦ Special Interest Groups — special
meetings held several times a month.
♦ Door prizes at the regular meeting.
Other benefits include:
♦ Special user group discounts on
books and software.
♦ A flash drive containing many
useful freeware programs.
♦ A chance to make friends with

people who have similar interests.
TOE subscription only (in the U.S.),
♦ The ability to put your knowledge $20.
to good use by helping other members.
CIPCUG E-MAIL ADDRESS
The whole concept of user groups is
Members who would like to have an
members helping members.
e-mail address through CIPCUG in the
form of YourName@cipcug.org may obPlease clip the coupon below and
tain one for $15 per year.
send with payment to CIPCUGMembership, P.O. Box 51354, Oxnard,
CIPCUG INTERNET SERVICE
CA 93031-1354.
TECH TEAM
Please make checks payable to
David Minkin, 469-6970 (cell), 484CIPCUG.
2974 (home)
dddave@cipcug.org
Dues for new members
Bob Thompson, 647-2287
Individual member, $40.
Family membership (same address),
$55.
Renewals are $30 and $35 per year
respectively.

CIPCUG MEMBERSHIP
APPLICATION

Can you help the club as a volunteer? If so, what would you
be interested in working on?

Amount enclosed: ____________________________
Please Print the following information:
Name: _______________________________________

Address: ______________________________________

City: ___________________________, State:________
Date __________________ Member # ____________
ZIP Code: _______________________________

Phone (Home): ______________(Work): ______________
E-mail address: ________________________________
User level: Novice ____; Intermediate _____; Advanced
_____

The Outer Edge
Channel Islands PC Users
Group Inc.
Page 24
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DUES REMINDER
If the number above your
name is 201012, your
membership dues are
payable in December
2010.

December 2010 meeting
Of the Channel Islands PC Users Group
The map shows
the easiest route
to the Boys &
Girls Club, but if
you prefer, you
can take the
Carmen Drive
offramp to
Ponderosa Drive,
which leads to
Temple Avenue.

Saturday morning, Dec. 18, at the Boys
& Girls Club, 1500 Temple Ave.
(Ponderosa Drive and Temple Avenue),
Camarillo.
Meeting Schedule:
8:30 a.m.
Doors open
8:45-9:30
Internet and networking SIG,
Hands-on Training
9:30-10:30
Business meeting, Q&A
10:30-11:00
Break — Please contribute requested
amounts for coffee and doughnuts
11:00-12:00
Program — OneNote, Christmas
gifts and gadgets
Drawing
1:30
After-meeting SIG by Michael
Shalkey (What To Ask For This
Christmas and What Can Wait)

